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Abstract
This edition of the Eclipse Plugin Guide applies to Squore 17.0.8 and to all subsequent releases and
modifications until otherwise indicated in new editions.

Licence
No part of this publication may be reproduced, transmitted, stored in a retrieval system, nor translated into any human or computer
language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior written

permission of the copyright owner, Squoring Technologies.

Squoring Technologies reserves the right to revise this publication and to make changes from time to time without obligation to notify
authorised users of such changes. Consult Squoring Technologies to determine whether any such changes have been made.

The terms and conditions governing the licensing of Squoring Technologies software consist solely of those set forth in the written
contracts between Squoring Technologies and its customers.

All third-party products are trademarks or registered trademarks of their respective companies.

Warranty

Squoring Technologies makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. Squoring Technologies shall not be liable for errors contained herein nor for incidental
or consequential damages in connection with the furnishing, performance or use of this material.
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Typographical Conventions

The following conventions are used in this manual.

Typeface or Symbol Meaning

Bold Book titles, important items, or items that can be
selected including buttons and menu choices. For
example: Click the Next button to continue

Italic A name of a user defined textual element. For
example: User nane : admin

Couri er New Files and directories; file extensions, computer
output. For example: Edit the confi g. xni file

Courier Bold Commands, screen messages requiring user action.
For example: User nanme : admin

> Menu choices. For example: Select Fi | e > Open.
This means select the File menu, then select the Open
command from it.

<> Generic terms. For example: <SQUORE_HOMVE>
refers to the Squore installation directory.

Notes

Screenshots displayed in this manual may differ slightly from the ones in the actual product.
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Acronyms and Abbreviations

The following acronyms and abbreviations are used in this manual.

Cl Continuous Integration
CLI Command Line Interface
DP Data Provider, a Squore module capable of handling

input from various other systems and import
information into Squore

RC Repository Connector, a Squore module capable
of extracting source code from source code
management systems.
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1. Introduction

This document was released by Squoring Technologies.

It is part of the user documentation of the Squore software product edited and distributed by Squoring
Technologies.

This document is the Eclipse Plugin Guide for Squore.
Its objective is to guide you through various aspects of the Squore Eclipse Plugin:

> Chapter 2, Introducing the Squore Eclipse Plugin positions the Squore Eclipse Plugin inside the Squore
ecosystem, explaining its main features.

> Chapter 3, Installing and setting up the Squore Eclipse Plugin describes the steps to follow in order to install
the Squore Eclipse Plugin.

> Chapter 4, Getting Started With the Squore Eclipse Plugin walks you through the features provided by the
Squore Eclipse Plugin.

If you are already familiar with Squore, you can navigate this manual by looking for what has changed since
the previous version. New functionality is tagged with (new in 17.0) throughout this manual. A summary of
the new features described in this manual is available in the entry * What's New in Squore 17.0? of this
manual's Index.

For information on how to use and configure Squore, the full suite of manuals includes:
2 Squore Installation Checklist

> Squore Installation and Administration Guide

2 Squore Getting Started Guide

2 Squore Command Line Interface

> Squore Configuration Guide

> Squore Eclipse Plugin Guide

> Squore Reference Manual

If the information provided in this manual is erroneous or inaccurate, or if you encounter problems during
your installation, contact Squoring Technologies Product Support: http://support.squoring.com/

You will need a valid Squore customer account to submit a support request. You can create an account on the
support website if you do not have one already.

For any communication:

S support@squoring.com

[=ISquoring Technologies Product Support
76, allées Jean Jaurés / 31000 Toulouse - FRANCE
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Approval of this version of the document and any further updates are the responsibility of Squoring
Technologies.

The version of this manual included in your Squore installation may have been updated. If you would like to
check for updated user guides, consult the Squoring Technologies documentation site to consult or download
the latest Squore manuals at http://support.squoring.com/documentation/17.0.8. Manuals are constantly
updated and published as soon as they are available.
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2. Introducing the Squore Eclipse Plugin

Squore analyzes projects (in a broad sense) to provide high level indicators and produce personalised
dashboards and tailored action lists for each kind of connected user. The whole process can be automated,
and integrated in a continuous integration framework.

Information generated in this fashion can be refreshed with any desired rate, and the results will be available
each time the Squore process concludes a new build. However, this scenario is best suited to a daily cycle at
most, where all input files are the result of a daily commit, and results are generated along with the nightly
build.

The Squore Eclipse Plugin is destined to operate at a faster rate, the objective being to deliver results during the
development process, before files are committed and fed to the continuous integration process. Tightening
the processing loop has several consequences for the Squore Eclipse Plugin behavior:

> It doesn't need to be connected to a central Squore server to rate a project, unless for project activation /
licence validation purposes.
By limiting communication with the server to a minimum, we make sure projects can evolve outside the
global rating cycle, but still offer the rating service.

Should the server be unreachable, rating service is still available for a whole week, before being deactivated.
Once a connection is available again, and the credentials are validated, the rating capabilities are restored.

¥

It must be able to process and rate a project locally
The Squore Eclipse Plugin runs the Squan Sources static code analyser on the sources in your Eclipse project.

Note that no other data provider is run by the Squore Eclipse Plugin, so the overall rating of your project
may vary from the one obtained when analysing the same for the same code base on Squore Server. Metrics
and violations returned by Squan Sources will nevertheless be the same.

> It must use a configuration (in terms of Analysis Model and Data Providers) synchronised with the one
installed on Squore Server
Since the Squore Eclipse Plugin uses a Squore rating module, it needs a rating environment, which must be
synchronised with the server's, to ensure results equivalence.

The Squore Eclipse Plugin will perform such synchronisation during the product activation, which is a feature
available in the Squore Eclipse Plugin preferences page.

¥

It must be able to manage projects using other languages than Java (e.g. C, C++, C# Ada)
The Squore Eclipse Plugin benefits from the Squore source code analyzer, which provides support for several
languages (see Squore documentation for more details).

Analysis results will be available at folder and file level.

> It must be integrated into the Eclipse IDE, taking advantage of its extendability
The Eclipse plugin development framework offers a number of mechanisms to enhance various parts of the
IDE.The added features have been designed to be both unobtrusive and informative.

> It must enhance a project's available information by displaying ratings, Action Items, Findings and highlights
for each compatible object
The added information is assigned to each artefact, which means at project, file, module, class and function
level. Each of these elements will have a rating, as well as a list of Action Items and Findings, depending on
the model. A search view offering project artefacts sorted by rating is also available.

¥

It must be able to manage local versions, which are dissociated from the source code control versioning
mechanism
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One of the differences between the Squore Eclipse Plugin and Squore is that Squore Server uses a database
to store the project builds across multiple versions, whereas the Squore Eclipse Plugin uses a local file
storage mechanism, to maintain a local history.

This allows functions such as DELTA VALUE or PREVI OUS_VALUE to work as expected, and produce
trend analysis indicators.

Trends are based on the evolution of indicators between a baseline analysis and the last-rated analysis.

As hinted by its name, the Squore Eclipse Plugin is a developer tool. Its objective is to provide users with
enough information to help them:

> Process the generated list of Action Items
> Check the evolution of the source code rating as it is being produced
> Find what artefacts are responsible for a poor rating, and understand why

> Anticipate and address problems that will appear in the project's daily Squore server build before the code
is referenced in a SCM system

As the Squore Eclipse Plugin seamlessly integrates Squan Sources results in the IDE, and uses the same model
as the one on Squore Server, developers will gain visibility over the evaluation process, and improve their
development practices to match the standard defined by the model.

The integrated rating feedback also gives the developer the opportunity to actively participate to the global
effort on quality improvement.
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3. Installing and setting up the Squore Eclipse Plugin

The following is a list of the officially supported and tested operating systems:

> CentOS 6

> CentOS 7

> Fedora 19

» Ubuntu Server 14.04
» Windows 7

» Windows 8

» Windows 10

Note
On Linux, a 64-bit version of the OS is required

On Windows, a 64-bit version of the OS is required if you want Squore to run as a Windows service,
but the installation is also supported on a 32-bit system (and is started and stopped using .bat files
instead of a Windows Service)

The following is a list of the operating systems that are not regularly tested but are known to be working:

> RedHat EL 6

> RedHat EL 7

> SuSe Linux 11.1

» Ubuntu Server 10.04

> Ubuntu Server 16.04

» Windows Server 2008 R2
» Windows Server 2012 R2

For a successful installation of Squore, you will need:

> The latest version of the Squore Eclipse Plugin, which can be downloaded from http://localhost:8180/
SQUORE_Server/eclipse

> The Oracle Java Runtime Environment version 8 (other versions are not supported)
> A supported Eclipse version (Luna SR2 and up)

> Valid credentials to log into a Squore Server

> At least 2 GB of space available on the disk for a full installation

> At least 8 GB of RAM on the server machine

> At least 4 GB of RAM on the client machine

A compatible version of Eclipse must be downloaded from http://www.eclipse.org/downloads/ .
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On Linux platforms, the following must be installed before installing Squore:

> Perl version 5.10.1 or greater including the following extra-modules:
> Mandatory packages:

> Algorithm::Diff [module details] [http://search.cpan.org/~nedkonz/Algorithm-Diff/lib/Algorithm/
Diff.pm]

> Archive::Zip [module details] [http://search.cpan.org/~phred/Archive-Zip/lib/Archive/Zip.pm]
> Date::Calc [module details] [http://search.cpan.org/~stbey/Date-Calc/lib/Date/Calc.pod]
> Digest::SHA [module details] [http://search.cpan.org/~mshelor/Digest-SHA/lib/Digest/SHA.pm]

> HTTP::Request [module details] [http://search.cpan.org/~gaas/HTTP-Message/lib/HTTP/
Request.pm]

> JSON [module details] [http://search.cpan.org/~makamaka/JSON/lib/JSON.pm]
> LWP [module details] [http://search.cpan.org/~ether/libwww-perl/lib/LWP.pm]

> LWP::UserAgent [module details] [http://search.cpan.org/~gaas/libwww-perl/lib/LWP/
UserAgent.pm]

> Time::HiRes [module details] [http://search.cpan.org/~zefram/Time-HiRes/HiRes.pm]
> XML::Parser [module details] [http://search.cpan.org/~toddr/XML-Parser/Parser.pm]
Tip
If some of these modules are not available as packages on your operating system, use your perl

installation's cpan to install the modules. Using the OS packages is recommended, as it avoids
having to reinstall via cpan after upgrading your version of perl.

> Tcl version 8.5 or greater,

> A supported Eclipse version (Luna SR2 and up)

On Red Hat Enterprise Linux and CentOS (6.5 and 7.1), the dependencies are satisfied by the following
packages:

Mandatory packages:

> java-1.8.0-openjdk
> perl

> perl-Algorithm-Diff
> perl-Archive-Zip

> perl-Date-Calc

> perl-Digest-SHA

> perl-JSON

> perl-libwww-perl
> perl-Time-HiRes

> perl-XML-Parser

> tcl

> A compatible installation of Eclipse downloaded from http://eclipse.org/downloads .
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For more information about how to install the Extra Packages for Enterprise Linux (EPEL) repository, consult
https://fedoraproject.org/wiki/EPEL.

On Ubuntu 14.04.3 LTS, the dependencies are satisfied by the following packages:
Mandatory packages:

> libalgorithm-diff-perl
> libarchive-zip-perl

> libdate-calc-perl

> libhttp-message-perl
> libjson-perl

> libwww-perl

> libxml-parser-perl

> openjdk-8-jre

> perl

> tcl

> A compatible installation of Eclipse downloaded from http://eclipse.org/downloads .

The Squore Eclipse Plugin complies with the Eclipse requirements, and is an OS-independent package to be
deployed in the Eclipse plugins directory. Installation is done through an update site.

Tip

In order to launch analyses, the plugin needs to use an installation of perl and tclsh. If you are using
a Windows operating system, the easiest way to install both dependencies is to install the Squore CLI
package on your machine following the procedure outlined in the Command Line Interface manual.

> Create a new update site within Eclipse

> Select Help > Install new software;.

> Click on Available Software Sites;.

> Add a new site;

> Give it a name (for example: "Squore Eclipse Plugin");

> Set the location to http://localhost:8180/SQuORE_Server/eclipse
> Go back to the "Install" window with the "OK" buttons;
> Select the newly created update site;

» Proceed with the plugin installation as with any Eclipse plugin.
Note

> To speed-up installation procedure, it is possible to uncheck "Contact all update sites during install
to find required software", as no external software is needed by the Squore Eclipse Plugin.

> Should the plugin fail to deploy, Eclipse will notify the user of the problem cause, and
will start its operations as usual. If necessary, copy and send the generated Eclipse log to
support@squoring.com.
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3.3. Squore Eclipse Plugin setup

To use the Squore Eclipse Plugin, it must be activated, the server must be reachable with proper credentials,
and rating preferences must be provided.

All these operations are accessible through the Window > Preferences > Squore page. Note that all provided
information uses the Eclipse secure storage.

iy

iy

| type filter text

General

Ant

Cloud Foundry

Code Recommenders
Data Management
Help

Install/Update

Java

Java EE

Java Persistence
JavaScript

JSON

Maven

Mylyn

Oomph

Plug-in Development
Remote Systems
Run/Debug

Server

b L L O L s L L L L L L

Squore
» Team
» Terminal
Yalidation
» Web

Squore

General settings for Squore Eclipse plugin

Envirenment configuration

Perl binary path: | Chelivtools\perlyperhbiniperl.exe

Tel binary path: | Chelivtoolsitelshibinitclsh85.exe

Server connection

Server url: | http://localhost:3180/SCu0ORE_Server

Check 5erver . Server is unreacheable,

User connection (optional)

User login: | demo

User password: |""*"""""""

Check User Server is unreacheable,

| Impeort Configuration from Server | (Unsynchronised) Use to retrieve environment from the server,

| Restore Qefauﬂs| E Apply

@ @®©

oK | Cancel |

The Squore Eclipse Plugin preferences page

Fill in the paths to the perl and tclsh executables and the server details and click Check Server to ensure that
your configuration is correct.

If you can successfully connect to the server, click Import Configuration from Server to synchronise your
environment with the one from Squore Server.

When the synchronisation finishes, click OK to close the preferences window.
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4. Getting Started With the Squore Eclipse Plugin

Once the Squore Eclipse Plugin is installed in Eclipse, obtaining a rating for your project is rather
straightforward.

First locate the Squore contextual menu entry for the project you want to rate.

it Squore > Build

wi?  Refresh F5 Build and Baseline

Close Project Clean

Close Unrelated Projects Build Automatically

FEE T Build Cenfiguration...

Contextual menu on an Eclipse project

Rating (or "building") a project with Squore Eclipse Plugin can either be performed as a baseline build or a
draft build.

» When choosing baseline build, the project rating will produce a new reference version, with which all
subsequent ratings will be compared to. This will affect rating computations based on metrics previous
values, as well as all trends displayed in the Squore Eclipse Plugin views.

The baseline mode is useful when a stable state of the project has been reached, and a development phase
is about to begin.

2 When choosing draft build, the project is rated as usual, but the reference version is not modified. Each
new draft build overwrites the previous analysis and displays trends and deltas relative to the last defined
baseline.

The draft mode is useful during a development phase, when the project can undergo several back and forth
changes, and the user wants to keep comparing the current version to the last stable one.

Before you can build a project, you first need to define its build configuration:
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@ squorek Configuration (kaptcha x
Load project parameters from:

(®) Wizard w
() Server Project

Key Yalue

QK Cancel

The Build Configuration screen

On the Build configuration screen, you can choose an analysis model for your project, or you can select the
project on the server that corresponds to the code you are working on locally. By selecting an existing project,
you can retrieve the project attributes from the server, and therefore run your local analysis in the same
conditions as it is run on the server.
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Load project parameters from:

() Wizard AMALYTICS

(®) Server Project | kaptcha (software_analytics) et

Key Value (N
APPLY_TO_BE_TESTED 1.0

COV_BRAMNCH_A 0.0

COV_BRAMNCH_B 100.0

COV_BRAMCH_C 100.0

COV_BRAMNCH_D 100.0

COV_MCDC_A 0.0

COV_MCDC_B 0.0

COV_MCDC_C 0.0

COV_MCDC_D 100.0

COV_STAT_ A 100.0

COV_STAT B 100.0

COV_STAT_C 100.0

COV_STAT D 100.0

LEVL_ THRESHOLD 4.0

PATH_THRESHOLD 5.0 w

Project options for the kaptcha project on the server

Click OK to close the configuration dialogue. You are now ready to start building your project using the draft
or baseline submenu in the Squore Eclipse Plugin context menu.

After your analysis completes, switch to the Squore perspective to view the results.

Tip
Click Window > Perspective > Open Perspective > Other and search for Squore in the list of available
perspectives if you are using it for the first time.

The Squore perspective displays various views with information relative to the file or folder you click in the
Project Explorer.

Ref : SUM_Squore_ECL_PLG Version : 17.0.8
Date : 30/11/2017
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-nech - Squore - kaptcha/srcfjava/com/google/code/kaptcha/core/FishEyeGimpy java - Eclipse —

urce FRefactor [MNavigate Search Project Bun Window Help

PACHEMNRi#-0- Q- OB A -iH-FT- oD [Quick Access|

lorer E3 = Q:H ¢ ~ — 0 o Moise.java FishEyeGimpy.java &3
3 ii 1 package com.google.code.kaptcha.core;
2

Systern Library [JavaSE-1.8] )
3@ import java.awt.Color;[]

. 8
_|E'||"E g .I'll**
= com 18 * {{@link FishEyeGimpy} adds fish eye effect with wvertical and horizontal ]
~ = google 1 *
v (= code dh 12 public class FishEyeGimpy implements GimpyEngine
13 {
w [ kaptcha 148 I
v (= core 15 * Applies distortion by adding fish eye effect and horizental vertical
DefaultBackground 15 * lines.
DefaultKaptcha.javi 17 *
DefaultNoise java 18 * fparam baseImage the base image
FichEveGimpy.iava 19 * f@return the distorted image
NoNoise java dh 21 public BufferedImage getDistortedImage(BufferedImage baseImage)
ShadowGimpy.java 22 I
WaterRipple java 23
S = impl 24 Graphics2D graph = (Graphics2D) baseImage.getGraphics();
ac B I L S ) e e T T T s ot B NP P Y
v = servlet
» = text
S = util ik Squore Card B8 | gl Action ltems gl Findings &l Highlights =] Console
rEEQUrCes FishE]reﬁimp]r_java
chstylexml
lbugs.xml D
dxml Measures/Indicators Value
Line Count 126 a
Source Lines Of Code 73 ﬂ
Effective Lines Of Code 51 a3
Executable Statements 42 ﬂ
Cyclomatic Complexity 12 a3
Complexity Distribution
Ratic of complex modules 8.3% C|
Mumber of Modules 3 ﬂ
Class Complexity Ratio 0.0% A
Mumber of Classes 1 ﬂ
Coding Rules Compliance
> Rule Compliance 99.68% (A
& [
The Squore Perspective with the Squore Card, Action items, Findings and Highlights views in the bottom panel
12
Ref : SUM_Squore_ECL_PLG Version : 17.0.8
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Click a file or folder in the Project Explorer and use one of the following views in the bottom panel to
understand your rating:

2 The Squore Card view
displays the overall rating for the current artefact, and its trend. It also lists the tables of interests for this
artefact, as defined in the Analysis Model used to rate the project.

ihis Sguore Card 52 | iy Action ltems gl Findings &l Highlights & Console

FishEyeGimpy.java

D

Measures/Indicators

Source Lines Of Code
Effective Lines Of Code
Executable Statements
Cyclomatic Complexity
Complexity Distribution
Ratic of complex modules
Mumber of Modules
Class Complexity Ratic
Mumber of Classes
Coding Rules Compliance
Rule Compliance

Mon Conformity Count
Mon Compliant Standards
Coding Standards

Issue Distribution
Blocker lssues

Critical lssues

Major lssues

Minor lssues

2 The Findings view
lists the Findings for the current artefact as well as underlying artefacts, with their location and definition
details. This list can be sorted, and allows navigation to artefacts associated to each finding by double-
clicking on their name.

Ref : SUM_Squore_ECL_PLG

The Squore card

Yalue

126
73
51
42
12

8.3% C |
0.0% A

09.68% A

b wviolations

2 rules
818 rules

o O o O

Version : 17.0.8
Date : 30/11/2017
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pabblie tne £1) |
Ent 1 = OF

=1, 4ar

if 1 == ) &

n e e WEOUORE] A Puncteon shall have a single point of exit at the e (see [MISRE-CA004) AULE 147§

retorn 1@

1

B String[] gechshirrsy|Collecticn<Strings o)

'h retarn (Stringl]l) c.tohrrayih:
3 v
|2 Probigms @ Jawmdor [ Declarabon =g Progress | d Fodngs B dly aciontems 8] TaskList =5

Tersd jasra (Tt 3; Minw: 3)

brefas Line Pyl Practice Kew 0P b
;geg‘-s_-ﬁ-r_rqﬁc_"tsﬁ_un_«jh'_i'lgsj 2l Class Cast Exception With ., This usage of the Collection toderayl) method will throree o ClassCastException, true  FMD R
gethsfermrdCollectionSiring»] 21 B Imipossble dovwncast . This cpdie is casting the result of calling bodirreyl) o 2 collectionts o type more specifi,.  tue  FINDEUGE R
F 14 Fukiple axits A Function thall have o srgls poart of exit ot the end (ses [MISEA-C-2008 RULE 14.7), true  SCOUORE Mo
£ *

A finding and its location in the source code

String[] gechshirray|Collectioncicrings ch [

i [Mukiple markers 2t this line

| | - (PKD] This urage of the Collection. tofimay() method will thow a ClassCastException,
= (FINDBLIGS] This code is et the resulk of calling oAmay]] on a collectionbs a bypes mone specife: thae Obgect]] | as i Sning|] getAsdns Colbectean<Snng> <)
{ retum (String(]} ctodreyil; § This wil usuelly fail by throwing & ClassCastEvception, The todomay) of elmost all cobections: return an Qbject|]. They can't really do anything L
elyesinge the Collection chject han ne relererc e ba the declared gerernic bype of the collestion. The comect way ba do get e array of a specific bype from a sollection Bt use
crofmayines Stnglll or ctolraylnew Stieglcsize0 | (e latter is shghtly more effecient). There is one common/known eseption exception to thes. The todirayp() methed of
lists returreed by &mays. sl ist,..) wall retum & covarizntivtyped sy, For example, Smaysasiney(nes String]) { ‘e fubodinmey) will rebum 2 String [] . FindBugs sttempls to detect

and suppressiuch caves, but may mis wome

A finding full description

2 The Action Items view
works much like the Findings one, except it lists the Action Items computed by the Decision Model, and the

reason why they have been generated.

g Problems @ Javadoc |1 Declarson S5 Frograss dy Findings  J odion kems 52 (5] TaskList =8
Testjava (Totak 2]

Artefact Id Flame Srope Septus  Pessons P‘i'ic.!li‘ty
h!&piur_ﬂﬂ'ﬁ_u&u_hgﬂ_(s_._l -3-510  Mumbar of Blacker and criizal nde ingmeaied [Ferction] OPEM  Mew artefact should be reiewed dus bo..  High
ettty Colleckion <5, Mo ‘Elocke’ rules [Furstion]  OPEM  ‘Blacker ndey (= 1] defected in hancticn, High
getdefimey{Collection <. -3-51.1  Mumber of high andd mujor nde inoreased [Furction]  OPEM  Mew Atefect should be reviesed diae to,. M.

Action Items

> The Highlights view
works much like the Findings one, except it provides a list of the current project's Files, Classes or Functions,
sorted by decreasing rating. Selecting the type of object to sort (File, Class or Function) is performed through
the top-left menu icons.

14
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i Problems @ Javadoc [2, Declaraion [ Console Jl Highlights 5% | Jl Findings

Test worst methods (Total: 171)

Artefact

Tip

doXMLFinding
endElement
getlocStr
startElement
Corefrtefact
addData
addDefectReports
addDefectReports
addDrLinksTestsDependencies
addInformation
addlocation
addlogicalFatherStr
add5Son

Line
310
570

549
76

179
115
219
551
435
56

482
423

Highlights

Only the highlights created for the role PLUGIN are displayed in Eclipse. For more information

about configuring highlights in your model, refer to the Configuration Guide.

Ref : SUM_Squore_ECL_PLG
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Index
A

Action Items view, 14

B

Baseline build, 9

D
Disk Space, 5
Draft build, 9

F

Findings view, 13

H
Highlights view, 14

J

Java, 5

M

Memory, 5, 5

P

Prerequisites, 5

S

Squore Card view, 13
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